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Introduction

What is ProntoEdit?

ProntoEdit is the visual editor for Pronto configurations. A Pronto configuration fully defines a Pronto user
interface including all devices, macro groups, panel layouts, button appearances, and button, direct-access
and left/right key behaviors (including all IR codes). ProntoEdit always has a single configuration open, the
current configuration. See What is a CCF? for more information on Pronto configuration files.

ProntoEdit provides two complementary views on the current configuration. On the left side of
ProntoEdit’s main window you’ll find the configuration view, a typical tree view of the overall structure of
the current configuration. At the top level of this tree view you’ll find HOME, DEVICES and MACRO
GROUPS. These top levels are associated with the home section, the right hand side device menu and the
left hand side macro group menu on your Pronto.

Underneath DEVICES is a list of devices, and underneath MACRO GROUPS is a list of macro groups.
Underneath HOME, every device and every macro group is a property item and a list of panels. The
property item underneath HOME provides access to the Pronto system properties, and the property item
underneath a device or macro group provides access to the properties of that device or macro group.
Included in these properties are the definitions of the direct-access and left/right keys.

On the right side of ProntoEdit’s main window you’ll find panel views. A panel view displays the contents
of a panel as it is defined in the current configuration. Panel views provide an up to date view on the

configuration view

panel view



ProntoEdit User Guide

6

current configuration, and any changes to a panel view are immediately incorporated into the current
configuration.

What is ProntoEmulator?

ProntoEmulator is a separate application, although part of the ProntoEdit package, which emulates every
aspect of a real Pronto1. You can use ProntoEmulator to test drive your configuration without the need to

download it to your Pronto. At any time you can launch ProntoEmulator from ProntoEdit by clicking on 
in the toolbar or selecting Run Emulator from the Tools menu.

When the cursor is over ProntoEmulator’s window, press the right mouse button to display a pop-up menu
to get access to the following ProntoEmulator functions: Help, About, Transparent, Minimize and Close.
Function Transparent is discussed in How can I make ProntoEmulator faster?.

                                                          
1 The speed of the emulator depends on your PC configuration and may differ from the speed
of the real Pronto.
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ProntoEdit system requirements

• PC with a 486DX/66 MHz or higher processor

• Windows 95, Windows 98, Windows NT 4.0 or higher operating
system

• 16 megabytes of RAM

• 10 megabytes of free disk space

• Super VGA or higher graphics card and monitor

• Available serial port which supports 115200 baud

ProntoEdit installation

We recommend that you close all programs before installing ProntoEdit.

When installing from floppy disk:

1. If you have ProntoEdit on floppy disks, skip to step 3.

2. If you have downloaded ProntoEdit.zip, unzip it and copy the
contents of directories disk1, disk2 and disk3 to separate floppy
disks.

3. Insert the first ProntoEdit floppy disk in your PC’s disk drive.

4. Display the floppy disk contents in explorer and double click on
Setup.exe.

5. Follow the on-screen instructions.

When installing directly from our web site:

1. Double click on the ProntoEdit link and either execute in place and
skip to step 3, or download  ProntoEdit.exe.

2. Double click on ProntoEdit.exe.

3. Follow the on-screen instructions.

The first time your run ProntoEdit, you have to accept the license agreement
or ProntoEdit will not run.
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What is a CCF?

A CCF, or Pronto configuration file, stores a single Pronto configuration. A
Pronto configuration fully defines a Pronto user interface including all devices,
macro groups, panel layouts, and button appearances and behaviors
(including all IR codes). CCFs have file extension ‘ccf’ and  icon , and
contain the following kinds of information:

• A Panel defines the rectangular area of your Pronto’s screen between
the menu bars at the top of the screen and the gray bar at the bottom
of the screen.

A panel consists of up to 255 frames or buttons, and in turn every
frame can contain up to 255 frames or buttons. Frames are inactive
user interface elements with either a background color or a bitmap,
and a name. Buttons are active user interface elements with a
background color or a bitmap for each of four different states, a name,
and an action list. An action list is a list of up to 255 actions. An
action can be a delay, an IR code, or a reference to another action
list. The last action of every action list can be a jump to a specific
panel.

• A Device is a list of panels plus an action list for every Pronto direct-
access and left/right key. A single device usually defines the control
buttons for a single ‘real live’ device, but this is not required. Devices
appear in the right hand side device menu of your Pronto.

• A Macro Group is a list of panels plus an action list for every Pronto
direct-access key (in a macro group, the left/right keys cannot have an
action list). A single macro group usually defines a number of related
macros, but this is not required. Macro groups appear in the left hand
side macro group menu of your Pronto.



ProntoEdit User Guide

9

Why would I use ProntoEdit?

One of the best features of the Pronto is its adaptability: you can make buttons and whole panels appear and
disappear, change button labels, learn IR codes, and create and edit your own macros. But if you want to
personalize your Pronto even more, ProntoEdit is the perfect tool for you.

With ProntoEdit you can make all the changes you can make on your Pronto. In addition, ProntoEdit allows
you to perform a range of powerful tasks, including:

• upload and download configurations from and into your Pronto

• add buttons to panels

• rearrange panels

• add panels to devices

• add new devices

• use your own bitmaps

• create your own custom devices

• make any button into a macro

• create macros in macros

• let any button take you to any panel

• replace the home panels with your own panels

How can this guide help me use ProntoEdit?

This guide provides step-by-step instructions for a range of common ProntoEdit tasks and is only intended
to get you started with ProntoEdit. This guide is not meant to be a ProntoEdit reference guide and we
encourage you to investigate the range of features offered by ProntoEdit which are not covered by this
guide.

A note on menus

Most ProntoEdit menu items are accessible both through the regular menus at the top of ProntoEdit’s
window and through so-called context menus. Click on your right mouse button to open a context menu for
the currently selected item.
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Loading and Saving

How do I upload a configuration from my Pronto?

1. Start ProntoEdit.

2. Connect one end of the Pronto serial cable to your Pronto and
connect the other end to a serial port of your PC.

3. Click on  in the toolbar, or select Upload from Pronto from the File
menu.

4. ProntoEdit now tries to connect to your Pronto. If ProntoEdit cannot
connect to your Pronto, it will display a message saying Pronto not
connected or not responding. You can click on the Details >>
button to open a window listing all the serial ports on your PC.

• If another application is using the serial port to which your Pronto
is connected you can either try another serial port or have the
other application release the serial port.

• If ProntoEdit could open the serial port to which your Pronto is
connected but still could not connect, check to see if both ends of
the cable are properly inserted and if Pronto’s batteries have not
run out. Then wait a few seconds and try again. If after a number
of tries ProntoEdit still cannot connect, try resetting your Pronto,
wait until it beeps twice and try again.

5. After connecting to your Pronto, ProntoEdit will upload the
configuration from your Pronto and load it into ProntoEdit. If
ProntoEdit’s current configuration is not empty, ProntoEdit will ask you
if you want to Merge with current configuration or replace it? If you
decide to merge, ProntoEdit will add all home panels, devices and
macro groups uploaded from your Pronto to the current configuration.
If you decide to replace, ProntoEdit will remove the current
configuration (if it has been modified, you will first be allowed to save
it) and replace it with the configuration uploaded from your Pronto.

You can cancel the upload at any time by clicking on the Cancel button.

It is best to not touch your Pronto’s screen or use any of your Pronto’s direct
access buttons, while uploading is in progress.
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How do I download a configuration into my Pronto?

1. Start ProntoEdit.

2. Connect one end of the Pronto serial cable to your Pronto and
connect the other end to a serial port of your PC.

3. Make sure you have a configuration in ProntoEdit either by uploading
one from your Pronto (see How do I upload a configuration from
my Pronto?) or by loading one from a file (see How do I load a
configuration from a CCF into ProntoEdit?).

4. Click on  in the toolbar, or select Download into Pronto from the
File menu.

5. ProntoEdit generates the configuration. If the resulting configuration
does not fit in your Pronto’s available memory, ProntoEdit will tell you
it is too large and cancel the download. Based on how oversized the
configuration is (ProntoEdit displays this information both in absolute
and relative terms) you should delete some elements and try again.

6. ProntoEdit now tries to connect to your Pronto. If ProntoEdit cannot
connect to your Pronto, it will display a message saying Pronto not
connected or not responding. You can click on the Details >>
button to open a window listing all the serial ports on your PC.

• If another application is using the serial port to which your Pronto
is connected you can either try another serial port or have the
other application release the serial port.

• If ProntoEdit could open the serial port to which your Pronto is
connected but still could not connect, check to see if both ends of
the cable are properly inserted and if Pronto’s batteries have not
run out. Then wait a few seconds and try again. If after a number
of tries ProntoEdit still cannot connect, try resetting your Pronto,
wait until it beeps twice and try again.

7. After connecting to your Pronto, ProntoEdit will check the
configuration in your Pronto.

• If your Pronto does not contain a valid configuration, ProntoEdit
will display a message saying Failed to get valid information
from Pronto, do you want to overwrite any configuration
currently in Pronto? Click No or Cancel if you don’t want to
overwrite the configuration in your Pronto. Click Yes to continue
downloading.

• If your Pronto contains a modified configuration, ProntoEdit will
display a message with the creation date and time of this
configuration, and ask you if you want to overwrite it. Click No or
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Cancel if you don’t want to overwrite the configuration in your
Pronto. Click Yes to continue downloading.

8. ProntoEdit will now download the configuration into your Pronto. After
downloading, your Pronto will tell you when it is ready to be used
again by beeping twice.

You can cancel the download at any time by clicking on the Cancel button, but doing so may result in a
corrupted configuration in your Pronto (you can fix this by fully downloading a configuration).

It is best to not touch your Pronto’s screen or use any of your Pronto’s direct
access buttons, while downloading is in progress.

How do I load a configuration from a CCF into ProntoEdit?

There are a number of ways to load a CCF into ProntoEdit.

• When ProntoEdit is running.

1. Load a CCF into ProntoEdit by doing one of the following

• drag a CCF and drop it on ProntoEdit, or

• click on  in the toolbar or select Open Configuration…  from
the File  menu and select a CCF

2. ProntoEdit now loads the selected CCF. If ProntoEdit has a non-
empty current configuration, ProntoEdit will ask you if you want to
Merge with current configuration or replace it?  If you decide to
merge, ProntoEdit will add all home panels, devices and macro
groups from the loaded CCF to the current configuration. If you
decide to replace, ProntoEdit will remove the current configuration
(if it has been modified, you will first be allowed to save it) and
replace it with the configuration from the loaded CCF.

• When ProntoEdit is not running.

1. Start ProntoEdit and load a CCF by doing one of the following

• double click on a CCF, or

• drag a CCF and drop it on the ProntoEdit icon
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How do I save the configuration in ProntoEdit in a CCF?

If the current configuration in ProntoEdit is not empty, you can save it in a CCF by clicking on  in the
toolbar, or selecting Save Configuration or Save Configuration As… from the File menu.  If you use
Save Configuration As… you can save the CCF in an old format, which will discard all timer and beep
actions.

If a saved configuration would not fit in your Pronto, ProntoEdit will tell you it is too large and cancel the
save. Based on how oversized the configuration is (ProntoEdit displays this information both in absolute
and relative terms) you should delete some elements and try again.
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Basic Tasks
In this section we assume ProntoEdit is running and contains the
configuration you want to change.

How do I start with the factory default CCF?

The ProntoEdit distribution comes with a single sample CCF in
<install>/Samples where <install> is the directory where ProntoEdit has been
installed. This sample CCF is called default.ccf and it contains the factory
default configuration loaded in your Pronto. Load this CCF to start with the
factory default CCF. See How do I load a configuration from a CCF into
ProntoEdit? for instructions on how to load a CCF into ProntoEdit.

Some things to note about the default CCF:

• The panels underneath HOME have buttons without a label or an
action. These buttons are used by your Pronto to put in aliases to
devices.

• The list of devices contains many devices with ()’s around there
name. These are device templates. Templates don’t appear in
Pronto’s device menu, but when you add a new device on the Pronto,
these are the devices you can select from.

If you use ProntoEdit instead of your Pronto to add new devices, you can
remove all templates. This speeds up saving and loading and leaves more
room in your Pronto’s memory for ’real’ devices (be sure not to overwrite
default.ccf so you can always get the templates back).

How do I open a panel view?

1. Find the name of the panel you want to open in the tree view on the
left side of the ProntoEdit window. Click on  in front of DEVICES or
MACRO GROUPS to display the list of all devices or macro groups.
Click on  in front of HOME, or a device or macro group name, to
display the list of all its panels.

2. Double click on the name of the panel you want to open. A panel view
for that panel will open in the area on the right side of the ProntoEdit
window.

Closing a panel view will not undo any changes made to that panel view. A
panel view is merely a view on the current configuration, and any changes to
it are immediately incorporated into the current configuration.
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How do I add a button to a panel?

1. Open the panel view of the panel to which you want to add a button.

2. If the button and frame gallery is not visible, open it by clicking on 
in the toolbar or selecting Gallery from the Tools menu.

3. Select a group of frames and buttons by clicking on the group’s name
in the list on the left side of the gallery window. Alternatively, you can
use the cursor UP and DOWN keys to change the selection.

4. Click on the button you want to add, drag it to the panel view and drop
it where you want to add it. If the button you want to add is embedded
in a frame, clicking on that button will select the entire frame. Hold
down a SHIFT key while clicking on a button in the gallery to select
only that button.

How do I remove a button from a panel?

1. Open the panel view of the panel with the button you want to remove.

2. Select the button you want to remove by clicking on it. A red frame will
appear around the selected button.

3. Press the DELETE key.

How do I move a button in a panel?

1. Open the panel view of the panel with the button you want to move.

2. Select the button you want to move by clicking on it. A red frame will
appear around the selected button.

3. Hold down the left mouse button and move the cursor to drag the
button to a new location. The status bar shows the current location of
the selected button. Alternatively you can use the cursor keys to move
the button. To move it faster with the cursor keys, hold the SPACE bar
at the same time.

How do I copy a button?

1. Open the panel view of the panel with the button you want to copy.

2. If you want to copy a button to another panel, then open the panel
view of the panel to which you want to copy a button.

3. Hold down a CTRL key, click on the button you want to copy, hold
down the left mouse button and drag the button to the location to
which you want to copy it, and release the left mouse button to drop
the dragged button.
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ProntoEdit does not support copying from one running copy of ProntoEdit to
another.

How do I rename a button?

1. Open the panel view of the panel with the button you want to rename.

2. Select the button you want to rename by clicking on it. A red frame will
appear around the selected button.

3. Press F2 and a name dialog with an on-screen keyboard will open.
Click on the Shift button to change from one keyboard layout to
another (the keyboard layouts are equal to the ones on your Pronto).
Click on a key button to add the symbol depicted on that button. You
can also use your PC keyboard to enter regular alphanumeric
characters.

4. Press the ENTER key when you’re done.

How do I change the font used in a button?

1. Open the panel view of the panel with the button of which you want to
change the font.

2. Double click on the button of which you want to change the font, or
select the button by clicking on it and press the INSERT key.

3. The button property sheet appears. Select the Name tab, and choose
a font from the drop down list.

4. Click on the Apply button to look at the result of the change in the
panel view, and click on the OK button to accept the change or on the
Cancel button to decline it.

How do I copy all bitmaps from one button to another?

After creating a button and putting a few actions into its action list, you may want to change the appearance
of that button without having to recreate the action list. You can easily do this by copying all bitmaps from
another button to this button.

1. Open the panel view of the panel with the button to which you want to
copy bitmaps.

2. If you want to copy bitmaps from a button in another panel, open the
panel view of that panel. If you want to copy bitmaps from a button in
the gallery, open the gallery (see How do I add a button to a panel?
for instructions on how to open the gallery).
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3. Press and hold an ALT key, click on the button from which you want
to copy icons, drag it to the button to which you want to copy bitmaps,
and drop the dragged button.

How do I assign an IR code to a button?

1. Open the panel view of the panel with the button to which you want to
assign an IR code.

2. Double click on the button you want to assign an IR code to, or select
the button by clicking on it and press the INSERT key.

3. The button property sheet appears. Select the Action tab.

4. If the list of actions is not empty, select an action by clicking on it and
press the DELETE key until the list is empty (merely to ensure that
this button will only have a single IR code assigned to it).

5. There are two ways to assign an IR code.

• to assign a code from the IR database:

a. Click on the IR button. A tree view of the IR database appears.

b. Select the IR code you want to add (only bold items in the tree
view can be selected) and either double click on it or click on
the OK button.

• to assign a code by learning it:

a. Connect one end of the Pronto serial cable to your Pronto and
connect the other end to a serial port of your PC.

b. Click on the Learn IR button.

c. Press the button you want ProntoEdit to learn on the remote
you want to learn from like you would do when learning on
your Pronto. ProntoEdit will return with one of three replies:

• Learning completed successfully. The learned code has
been put in the list of actions. Press the OK button to close
the button property sheet and assign the code to the
selected button.

• Learning failed (timeout). ProntoEdit successfully
connected to your Pronto, but somehow couldn’t learn the
code. Try again and if it still doesn’t work, refer to your
Pronto user guide to trouble shoot IR code learning.

• Pronto not connected or not responding. You can click
on the Details >> button to open a window listing all the
serial ports on your PC.
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• If another application is using the serial port to which
your Pronto is connected you can either try another
serial port or have the other application release the
serial port.

• If ProntoEdit could open the serial port to which your
Pronto is connected but still could not connect, check
to see if both ends of the cable are properly inserted
and if Pronto’s batteries have not run out. Then wait a
few seconds and try again. If after a number of tries
ProntoEdit still cannot connect, try resetting your
Pronto, wait until it beeps twice and try again.

See How do I create a macro? for information on how to assign more than a single IR code to a button.

How do I assign an IR code to a direct-access or left/right key?

The Pronto has two kinds of key definitions: global and per-device. Whenever there is no per-device
definition (or an empty per-device definition), the global definition is used. There is only one global
definition per key, but there is a per-device definition per key for every device and macro group.

• to assign an IR code to the global definition of a key:

1. Double click on System Properties underneath HOME in the
configuration tree view.

2. The Pronto system property sheet appears. Select the tab of the
key to which you want to assign an IR code, and proceed with
step 4 of How do I assign an IR code to a button?

• to assign an IR code to the per-device definition of a key:

1. Double click on the Properties item underneath the device or
macro group in the configuration tree view for which you want to
assign an IR code.

2. The device or macro group property sheet appears. Select the tab
of the key to which you want to assign an IR code, and proceed
with step 4 of How do I assign an IR code to a button?

How do I assign a source switch IR code?

1. Double click on the Properties item underneath the device or macro
group in the configuration tree view for which you want to assign a
source switch IR code.

2. The device or macro group property sheet appears. Select the Action
tab and proceed with step 4 of How do I assign an IR code to a
button?
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How do I let a button jump to a panel?

Any button (or key) can jump to any panel (or be a link to that panel). This is a very powerful feature which
allows you to create your own Pronto user interface structure.

1. Open the panel view of the panel with the button to which you want to
assign a ‘jump action’.

2. Double click on the button to which you want to assign a ‘jump action’
or select a button by clicking on it and press the INSERT key.

3. The button property sheet appears. Select the Action tab.

4. Select the panel to jump to in the Jump drop down list.

There are a couple of special ’panels’ in the Jump drop down list:

• MOUSE MODE switches your Pronto into a mouse mode in which
your Pronto's touch screen acts as a DVX8000 compatible touch pad.

• SCROLL UP scrolls up to the previous panel, exactly like the scroll
button at the top of your Pronto's screen would do.

• SCROLL DOWN scrolls down to the next panel, exactly like the scroll
button at the bottom of your Pronto's screen would do.

Your Pronto has to be updated to APP V4.4 or later in order for SCROLL UP
and SCROLL DOWN to work (panel 3 of Setup on your Pronto displays
version information). Trying to use these ’jumps’ on a Pronto with an older
application will result in a crash. Please refer to How do I update the
software in my Pronto? for details on how to update.

How do I move a panel?

1. Select the panel you want to move in the tree view on the left side of
the ProntoEdit window.

2. Hold down the left mouse button and drag the panel to its new
location. If you drop a panel on another panel, it will be inserted
before the panel you drop it on. If you drop a panel on HOME, a
device or a macro group, it will be appended to the list of panels of
HOME, that device or that macro group.

Alternatively, move the selected panel up or down its current list by
holding down a CTRL button while using the cursor UP or DOWN key.

How do I copy a panel?

1. Select the panel you want to copy in the configuration tree view.
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2. Press CTRL + C or select Copy from the Edit menu to copy the
selected panel into ProntoEdit’s clipboard.

3. Select HOME, or the device or macro group you want to copy the
panel to and press CTRL + V or select Paste from the Edit menu.

ProntoEdit does not support copying from one running copy of ProntoEdit to
another.

How do I add a panel?

Select a panel, HOME, or the device or macro group to which you want to add a panel and click on  in
the toolbar or select Add Panel from the Panel menu. If a panel is selected, the newly added panel is
inserted just before the selected panel.

A newly added panel has the default contents of a home, device or macro
group panel. To add an empty panel, hold down a SHIFT key while adding
the panel.

How do I move a device or macro group?

1. Select the device or macro group you want to move in the tree view
on the left side of the ProntoEdit window.

2. Hold down the left mouse button and drag the device or macro group
to its new location. If you drop a device or macro group on another
device or macro group, it will be inserted before the device or macro
group you drop it on. If you drop a device or macro group on
DEVICES or MACRO GROUPS, it will be appended to the list of
devices or macro groups.

Alternatively, move the selected device or macro group up or down its
current list by holding down a CTRL button while using the cursor UP
or DOWN key.

Devices and macro groups are essentially equal. It is merely its location,
underneath DEVICES or underneath MACRO GROUPS, which makes a
device a device and a macro group a macro group. You can move a device
from DEVICES to MACRO GROUPS to turn that device into a macro group,
and vice versa.

How do I copy a device or macro group?

1. Select the device or macro group you want to copy in the
configuration tree view.

2. Press CTRL + C or select Copy from the Edit menu to copy the
selected device or macro group into ProntoEdit’s clipboard.
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3. Select DEVICES or MACRO GROUPS and press CTRL + V or select
Paste from the Edit menu.

4. If you copy a template device (a device with ()’s around its name), the
copy will also be a template device. Select Is Template in the Device
menu to change a template device into a regular device.

ProntoEdit does not support copying from one running copy of ProntoEdit to
another.

How do I add a device or macro group?

Click on  in the toolbar or select Add Device from the Device menu to add a device. Click on  in the
toolbar or select Add Macro Group from the Macro Group menu to add a macro group.

A newly added device or macro group is completely empty.

How do I update the software in my Pronto?

The software in your Pronto can easily be updated to a later version. Pronto software is distributed in single
files, called Pronto Update Files. When you double click on a Pronto Update File, it will launch ProntoEdit
which will take you through the updating process.  After completing an update, ProntoEdit will ask you if
you want to make the Pronto Update File, the standard Pronto Update File. The standard Pronto Update
File is used if you select Update Pronto… from the Tools menu in ProntoEdit.

ProntoEdit is distributed with a standard Pronto Update File with the latest
available Pronto software. We strongly advise you to update your Pronto
using this Pronto Update File.

Before you start the updating process, you should connect one end of the Pronto serial cable to your Pronto
and connect the other end to a serial port of your PC. During the update process, you should read the
messages that appear on your PC screen and push the appropriate buttons.

It is possible that after updating your Pronto, it asks you to calibrate the touch screen. Please refer to your
Pronto User Guide for detailed instructions on calibration.

It is best to not touch your Pronto’s screen or use any of your Pronto’s direct
access buttons, while updating is in progress.
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Timers
On your pronto there is the possibility to execute a certain action at a
predefined time and day.  This functionality is called a timer.

In ProntoEdit it is possible to add a timer to every button, device or macro that is defined.  On your pronto
however timers can only be edited in macro buttons.  This means that you can add a “hidden” timer to a
device button, which cannot be edited by the user.

A timer can have a START and a STOP action, each with their own time and day of execution.

How do I create — add a Timer Group?

• Select a Macro Device, press the left mouse key, select the option “Is
TimerGroup

• Or : Select a Macro Device, on the Menu bar select “Macro Group”, select
“Is TimerGroup”

The Macro Group will now be displayed between the brackets ‘<‘  ‘>

How do I create — add a Timer Action

A Timer Action – like any other Pronto action – can be added in an actionlist of a button, a key or a device,
using the properties box.

Only an “alias” action can be assigned as the START/STOP action of a timer. Pressing the “action key” will
open the ‘Alias” dialog box, from which an “alias” can be selected.

Unlike “Pronto”, ProntoEdit only uses a 24-hour clock. The default time displayed in the START & STOP
time is 00:00. Initially, no days are selected.

How do I repeat a timer action weekly?

In the timer edit dialog mark the checkbox labeled “Wkly”.  In this case, when a timer action was triggered,
it will be rescheduled at the same day and hour.

You can do this separately for the start and stop actions.
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Advanced Tasks
In this section we assume ProntoEdit is running and contains the configuration you want to change. We
also assume that you know how to open specific panel views.

How do I resize a button or a frame?

Buttons and frames can only be resized if they do not have any bitmaps. If a button has one or more
bitmaps, the width of the button is fixed to the smallest width of all its bitmaps and the height of the button
is fixed to the smallest height of all its bitmaps. The same is true for frames except that a frame can have at
most one bitmap.

If a button or frame has no bitmaps, you can resize it as follows:

1. Select the button or frame you want to resize by clicking on it. A red
frame will appear around the selected button or frame.

2. Release the left mouse button and move over the edge of the button
or frame until the cursor changes into a resize cursor with the desired
orientation.

3. Hold down the left mouse button and move the cursor to drag the
edge underneath it and resize the button or frame. The status bar
shows the current size of the selected button or frame.

Alternatively you can use the cursor keys to resize the button or
frame. Hold down a SHIFT key to move the top or left edge, and hold
down a CTRL key to move the bottom or right edge. To move an edge
faster with the cursor keys, hold the SPACE bar at the same time.

You can only resize a button or frame if it has no bitmaps.

How do I use my own bitmaps?

Every button or frame can have its own unique bitmaps. A buttons can have up to four bitmaps, one for
each of its states. A frame can have only one bitmap.

Bitmaps take up memory and having many different bitmaps means there is
less room for other data, like IR codes. You can help minimize the memory
bitmaps require by reusing bitmaps, where possible, on your buttons and
frames. ProntoEdit checks for equal bitmaps when saving a configuration by
looking at the actual bitmap contents, and only saves unique bitmaps

The four states of a button are (press the function key listed with each state to change the state of the
selected button into that state).

• inactive and unselected (F5)

• inactive and selected (F6)
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• active and unselected (F7)

• active and unselected (F8)

A button is active when it has a non-empty action list. It is inactive when it has
no action list or its action list is empty. A button is selected when you push on
it on the Pronto. It is unselected when it is waiting to be pushed.

To set a bitmap of a button, take the following steps:

1. Double click on the button you want to set a bitmap for, or select the
button by clicking on it and press the INSERT key.

2. The button property sheet appears. Select the Inactive Icons or the
Active Icons tab.

3. Click on the Load button underneath the bitmap you want to load, and
select a Windows bitmap file. ProntoEdit can load any Windows
bitmap file that has 1, 4 or 8 bits per pixel and is at most 240 by 219
pixels (the size of a panel). ProntoEdit will automatically convert a
color bitmap into a grayscale version more suitable for display on your
Pronto.

4. Click on the OK button to accept the new bitmap or on the Cancel
button to decline it.

To set the bitmap of a frame, take the following steps:

1. Double click on the frame you want to set the bitmap for, or select the
frame by clicking on it and press the INSERT key.

2. The frame property sheet appears. Select the Icon tab.

3. Click on the Load button, and select a Windows bitmap file.
ProntoEdit can load any Windows bitmap file that has 1, 4 or 8 bits
per pixel and is at most 240 by 219 pixels (the size of a panel).
ProntoEdit will automatically convert a color bitmap into grayscale
version more suitable for display on your Pronto.

4. Click on the OK button to accept the new bitmap or on the Cancel
button to decline it.

If a button has one or more bitmaps, the width of the button is fixed to the
smallest width of all its bitmaps and the height of the button is fixed to the
smallest height of all its bitmaps. The same is true for frames except that a
frame can have at most one bitmap.

How do I create a macro?

On your Pronto there is a clear distinction between macros and ‘regular buttons’. In ProntoEdit such a
distinction does not exist. Every button and every direct-access or left/right key can either perform a single
action, like transmit an IR code, or be a macro and perform a whole list of actions.
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All macros can be used on your Pronto, but only macro buttons in a macro
group panel can be edited on your Pronto.

To create a macro, take the following steps:

1. Double click on a button or select a button by clicking on it and press
the INSERT key.

2. The button property sheet appears. Select the Action tab.

3. The currently assigned list of actions is displayed on the right side of
the property page. The currently assigned jump panel is displayed
underneath the list of actions. Click on one of the buttons on the left
side of the property page to add an action to the list:

• Alias: click on this button to open a tree view of all devices, direct-
access and left/right keys, and buttons in the current CCF. Select
an item to add an alias to that item to the action list. When your
Pronto is executing an action list and comes across an alias, the
action list referred to by that alias is executed. Aliases are shown
in the action list preceded by [A] for a device alias, [K] for a direct-
access or left/right key alias, and [B] for a button alias.

• Delay: click on this button to add a delay to the action list. Hold a
SHIFT key while clicking on this button to set the default delay
duration. You can always double click on a delay in the action list
to change its duration. Delays are shown in the action list
preceded by a [D].

• IR DB: click on this button to open a tree view of the IR database.
Select an item to add an IR code from the database to the action
list. IR codes are shown in the action list preceded by a [C].

• RC5/6: click on this button to define an RC5 or RC6 mode 0 IR
code. RC5 and RC6 mode 0 codes are shown in the action list
preceded by a [C].

• RC-MM: click on this button to define a basic mode RC-MM IR
code. RC-MM codes are shown in the action list preceded by a
[C].

• Learn IR: click on this button to learn an IR code using your
Pronto. See How do I assign an IR code to a button? for more
information on learning an IR code using ProntoEdit. Learned IR
codes are shown in the action list preceded by a [C].

• Delete : click on this button to delete an action from the action list.

• Beep : click on this button to add a beep to the action list.  You
must enter Frequency, Duty Cycle and Duration.  You can always
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double click on a Beep in the action list to change these
parameters. Beeps are shown in the action list preceded by a [S]

4. Repeat step 3 to add up to 255 actions to the action list.

5. If you want your Pronto to ‘jump to’ a specific panel when it is done
executing the action list, select the panel to jump to in the Jump drop
down list.

When executing an action list, your Pronto ignores panel jumps in aliases.

Actions can be moved up or down the action list, by selecting the action to be moved, holding down a
CTRL key and using the cursor UP or DOWN keys. Alternatively, you can drag actions up or down the
action list using the mouse.

How can I use panel view grids?

Panel view grids are a helpful tool to line up buttons and frames. A panel view grid is a set of up to 64
horizontal and 64 vertical line segments. The main use for grids is grid snapping, which restricts button and
frame locations to grid locations, the locations where the line segments of a grid intersect. Grid snapping
affects button and frame moving, dropping a button or frame dragged from a panel or the gallery, as well as
button or frame resizing.

All grid functions are accessible through the Grid submenu of the Panel menu or the Grid submenu of the
panel view pop-up menu. Default grid settings, which affect all newly opened panel views, can be set in the
Settings menu. The following is an overview of some of the things you can do with grids:

• ProntoEdit stores 10 different default grids, which are automatically
assigned to a panel view when it is opened. The grids can be modified
per panel view without affecting the default grids. Use the Set Default
Grid submenu of the Settings menu to set any of ProntoEdit’s default
grids to the current grid of the active panel view.

• To change the current grid of a panel view, enable grid editing by
selecting Edit Grid in the Grid submenu. The Edit Grid item is only
enabled if a grid is currently visible.

• A horizontal grid line can be added by holding down a CTRL key
while clicking on a horizontal grid line. A similar approach works
for vertical grid lines.

• The selected grid line can be deleted by pressing the DEL key.
Note that every grid must contain at least one horizontal and one
vertical grid line. Therefore, the last horizontal and vertical grid line
cannot be deleted.

• When you put the selected grid line on top of another grid line and
you deselect the selected grid line, the selected grid line is
deleted.

• To add a vertical grid line to the right of two other vertical grid lines
at the same distance as the distance between the two other
vertical grid lines, hold down a CTRL key and press the cursor
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RIGHT key. A similar approach works for a vertical line to the left
of two vertical grid lines and horizontal grid lines.

• To create an evenly spaced grid, use the Auto Grid…  menu item.

• By default ProntoEdit snaps the top left corner of a button or frame to
the nearest grid location. However, you can instruct ProntoEdit to
snap to any corner or the center of a button or frame using the Snap
Mode  submenu of the Grid  submenu. Note that the snap mode does
not affect resizing, only placement or moving.

• To make the current grid of panel A the current grid of panel B: make
the current grid of panel A default grid 9 (or any other unused grid, we
just picked 9 for this example), close panel B, open panel B, and
select grid 9.

• To move an entire grid, hold down a SHIFT key and use the mouse or
the cursor UP or DOWN key to move the grid.

• Use the Export Grids  or Import Grids  items in the Files  menu to
export or import the default grids to or from a text file. This allows you
to keep your grids with your CCFs and makes it easier to make
changes to your CCFs afterwards.

Grids are not stored in CCFs.

How can I better select in a panel view?

Here are some tips that can help you select the right button or frame when a panel contains many elements:

• If a button or frame is selected and the move or resize cursor is visible
when you press the left mouse button, the selection does not change.
Therefore, clicking on a button in a selected frame does not select
that button. If you want to select the topmost button or frame at the
cursor location, press the ESC key before pressing down the left
mouse button. Pressing the ESC key will always deselect the current
selection.

• Press the TAB key to select the next sibling of the selected button or
frame. Hold down a SHIFT key while pressing the TAB key to select
the previous sibling of the selected button or frame.

• Use the zoom feature to get a better view of what you are selecting.

How can I make ProntoEmulator faster?

If you find ProntoEmulator a little slow you can make it faster by changing the shape of ProntoEmulator’s
window into a rectangle. To do this, right click on ProntoEmulator’s window to activate its pop-up menu,
and select Transparent.
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How can I make a screenshot in ProntoEmulator?

Simply press the PRINT SCREEN button to save the currently displayed screen of ProntoEmulator in a
Windows bitmap file. ProntoEmulator will tell you the full path of the file it saves (the screen shots usually
go into directory C:\ProntoScreens). ProntoEmulator saves up to 100 screenshots before it starts using the
same filenames again.

How can I create my own gallery?

ProntoEdit loads the gallery from <install>/gallery.ccf, where <install> is the directory where ProntoEdit
has been installed. Simply load gallery.ccf as a regular CCF (which it is), make modifications like you
would do for any other configuration, and save the modified configuration back in gallery.ccf. The next
time ProntoEdit is started, it will use the modified gallery.

Note that ProntoEdit ignores all but the GALLERY panels of gallery.ccf (HOME has been renamed into
GALLERY in gallery.ccf).

How can I create my own default panels?

ProntoEdit loads default panels from <install>/home.ccf,
<install>/device.ccf, and <install>/macro.ccf, where <install> is the directory
where ProntoEdit has been installed. Simply load any of these CCFs, modify
the configuration, and save it back. The next time ProntoEdit is started, it will
use the modified default panels.

The default macro panel CCF serves a second purpose: when you create a
new macro group on your Pronto, the panels of that macro group are actually
copies of the default macro panel.

Note that ProntoEdit ignores all but the first DEFAULT panel of a default
panel CCF (HOME has been renamed into DEFAULT in the default panel
CCFs).

How can I write-protect a configuration?

A write-protected configuration cannot be altered on your Pronto. This is useful if you want to set up a
configuration with ProntoEdit and don’t want anyone to inadvertently make changes to it when they use
your Pronto.

After loading a write-protected configuration in your Pronto, you can only
access USE mode on your Pronto. Write-protecting a configuration does not
affect any ProntoEdit operations.

A configuration can be write-protected by taking the following steps:

1. Double click on System Properties underneath HOME in the
configuration tree view.

2. The Pronto system property sheet appears. Select the Pronto
System Properties tab.
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3. Check the configuration is write-protected box to make this
configuration write-protected.

How can I create my own home panels?

By default, Pronto’s home panels contain aliases to all devices in Pronto’s
device menu. If you don’t need these aliases, you can create your own home
panels. Your Pronto automatically puts aliases on the home panels if all of
the following conditions are met:

• there is at least one home panel

• the first home panel is named ‘home’ (all lowercase)

• the home panels are write protected (see check box in Pronto
System Properties)

If you make sure at least one of these conditions is not met, the automatic alias creation is disabled and you
can create your own home panels in ProntoEdit.

You can even replace the home icon with your own 40 x 24 pixel icon.

How can I copy a device from one CCF to another?

Running copies of ProntoEdit do not share a clipboard. This means that you
cannot copy a device from one CCF to another by running two copies of
ProntoEdit and simply copying the device. Here is a workaround:

1. Load the CCF from which you want to copy a device.

2. Delete all but the device you want to copy.

3. Load the CCF to which you want to copy the device, and merge it with
the current configuration.

4. Save the configuration in the proper CCF.


